
Chapter 1

Getting to Know 
AutoCAD
Opening either AutoCAD or AutoCAD LT for the very first time can be an 
intimidating experience. Faced with such an expansive collection of tools, 
settings, and more, where do you start? To help you answer that question, 
this chapter breaks down the many components of the user interface into 
manageable segments and introduces you to basic operations such as open-
ing drawings. Even if you’ve used earlier versions of AutoCAD, you’ll still 
want to review this chapter to become acquainted with some of the changes 
from recent years.

Although the 2012 release does have some subtle user interface improve-
ments, the AutoCAD and AutoCAD LT interfaces are almost identical. Generally 
speaking, both platforms offer the same 2D drafting experience. The biggest 
difference is that AutoCAD LT has no 3D capability. AutoCAD offers many 
powerful tools for modeling in 3D that are not found in AutoCAD LT. (These 
tools are the topic of Chapter 16, “Creating 3D Geometry,” and Chapter 17, 
“Rendering and Materials.”) With so little separating the two platforms, for 
most purposes in this book I’ll refer to both interchangeably as AutoCAD 
unless otherwise specified.

�� Opening a new drawing

�� Becoming familiar with the AutoCAD and AutoCAD LT Application 
windows

�� Modifying the display

�� Displaying and arranging AutoCAD tools
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Starting AutoCAD
If you installed AutoCAD by using the default settings for the location of the 
program files, start the program by choosing Start ➢ Programs ➢ Autodesk ➢ 
AutoCAD 2012 ➢ AutoCAD 2012 or by choosing Start ➢ Programs ➢ Autodesk ➢ 
AutoCAD LT 2012 ➢ AutoCAD LT 2012, depending on your program. (This com-
mand path might vary depending on the Windows operating system and scheme 
you are using.) Alternatively, you can find and double-click the AutoCAD 2012 
icon or the AutoCAD LT 2012 icon on your desktop.

N O T E   ​You can also use AutoCAD-based products such as AutoCAD 
Architecture or AutoCAD Civil 3D to learn the topics covered in this book. To 
use one of these vertical products, choose Start ➢ Programs ➢ Autodesk ➢ 
AutoCAD Product Name 2012 ➢ AutoCAD Product Name As AutoCAD 2012.

Accessing Autodesk Exchange for AutoCAD
Autodesk Exchange for AutoCAD opens when the application is first launched, 
and provides integrated access to the popular AutoCAD Exchange (http://
autocad.autodesk.com). Similar to the Welcome screen found in earlier 
releases, the Autodesk Exchange window shown in Figure 1.1 leads to several 
resources including application downloads, help content, videos, and even 
community-generated content such as blogs and discussion forums.

The following elements make up the Autodesk Exchange For AutoCAD window:

Home Tab ​   ​The most prominent component of the Home tab is a feature slider 
highlighting the latest tips, tricks, and information related to AutoCAD. As seen 
in Figure 1.1, below the feature slider are several links to additional resources, 
including a list of productivity enhancing Featured Videos and Featured Topics.

On the right edge of the Autodesk Exchange For AutoCAD window are several 
links. Starting from the top, you will find direct links to the top-selling AutoCAD 
products from the store. Just below are several Important Links to resources 
such as Product Support and the Subscription Center.

Help Tab ​   ​Providing easy access to the AutoCAD help system, the Help tab brings 
several learning resources together in one place. Here a long list of resources 
including product documentation, product support, blog articles, tips and tricks, 
expert responses to questions, and more may be browsed and searched simultane-
ously (see Figure 1.2).
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F i g u r e   1 . 1  ​ The Autodesk Exchange window featuring a collection of AutoCAD resources

F i g u r e   1 . 2  ​ Accessing AutoCAD help documentation
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Along the right edge of the Help tab is a list of additional resources. Among 
these resources is a link to a collection of Getting Started Videos. These Getting 
Started Videos go beyond the topic of what’s new and instead dig deeper, offer-
ing a more comprehensive look at a complete process (see Figure 1.3). Here you 
can gain a better understanding of topics such as 3D modeling or even take a 
guided tour of the user interface.

F i g u r e   1 . 3  ​ Getting Started Videos as found in the AutoCAD Exchange  
For AutoCAD window

After exploring the Autodesk Exchange For AutoCAD window, you may prefer 
to disable it from automatically loading each time you start the software. This 
can be done by deselecting the check box labeled Show This Window At Start Up 
in the lower-left corner of the window. Even after choosing this option, you can 
still quickly access the window by using the Exchange button found on the right 
end of the AutoCAD title bar.

Understanding the Customer Involvement Program
AutoCAD 2012 is among a large number of Autodesk products that provide the 
opportunity to participate in a customer involvement program (CIP). The CIP is 
designed to collect nonpersonal information about your Autodesk products and 
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computer system to help the product programmers and developers design soft-
ware that best meets your needs. If you haven’t yet agreed or declined to partici-
pate, the Customer Involvement Program dialog box (Figure 1.4) might prompt 
you to join when you first start AutoCAD.

F i g u r e   1 . 4  ​ The Autodesk Customer Involvement Program dialog box

Participation is strictly voluntary and, if you choose to participate, AutoCAD 
will periodically send a small file to Autodesk containing information such 
as your software name and version, the commands you use, and your system 
configuration information. An Internet connection is required, and you must 
ensure that your firewall settings don’t prevent the information from being 
transmitted.

Exploring the AutoCAD User Interface
After you dismiss all of the initial dialog boxes, AutoCAD opens to display its 
default user interface, or UI as it’s sometimes called. Collectively known as the 
Application window, the user interface can be broken down into numerous 
parts. Many of these parts remain unchanged regardless of how the software is 
configured, whereas other elements may not always be viewable. I’ll explain how 
AutoCAD chooses to configure the user interface shortly. At this point, however, 
your graphics window should look similar to Figure 1.5.
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Application Menu Quick Access Toolbar

Ribbon tab Ribbon Panel Info Center

Ribbon
View Cube

Navigation Bar

Cursor

In-canvas Viewport Control

UCS Icon

Command Prompt Command Line Window

Coordinate Readout

Status Bar

F i g u r e   1 . 5  ​ The AutoCAD Application window’s Drafting & Annotation workspace

Using Standard AutoCAD Workspaces

AutoCAD provides the following standard workspaces:

Drafting & Annotation ​   ​Utilizing the Ribbon, this workspace (shown previously 
in Figure 1.5) is considered the default workspace. Unless otherwise specified, 
this is also the workspace used throughout this book.

AutoCAD Classic ​   ​Mimics the menu-based interface utilized prior to 
AutoCAD 2009.

3D Basics ​   ​Provides the core tools needed to get started with 3D modeling 
inside AutoCAD. (For AutoCAD users only. 3D features are not included in 
AutoCAD LT.)

3D Modeling ​   ​Provides the complete set of 3D modeling tools found inside 
AutoCAD, including materials via the Materials Browser. (For AutoCAD users 
only. 3D features are not included in AutoCAD LT.)

P

AutoCAD and 
AutoCAD LT offer 
numerous dialog 
boxes with various 
combinations of but-
tons and text boxes. 
You’ll learn many 
of their functions 
as you progress 
through the book.
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Switching the Current Workspace

Whether you choose to develop your own custom workspace or just use one that 
comes with the software, you may switch your current workspace at any time. 
As you become more comfortable with the software, you’ll likely choose to build 
a workspace that better matches the way you use AutoCAD. You’ll be using the 
Drafting & Annotation workspace for the first 15 chapters in this book. In the 
final two chapters, you’ll switch to the 3D Modeling workspace (Figure 1.6). For 
now, however, you need to get your AutoCAD user interface to look like Figure 1.5.

F i g u r e   1 . 6  ​ The AutoCAD Application window’s 3D Modeling workspace

N O T E   ​The illustrations in this book show the drawing area of the 
AutoCAD user interface with a white background; however, the default and 
preferred method is to use a dark gray or black background to reduce eye-
strain. The color choice in the book is simply for readability.

If your screen looks like Figure 1.6 or isn’t at all like Figure 1.7, you need to 
make a few changes:

	 1.	 Click the Workspace drop-down from the Quick Access toolbar, and 
choose Drafting & Annotation, as shown in Figure 1.7. Alternatively, 
Command Line users can enter the following:

WSCURRENT↵
drafting & annotation↵
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F i g u r e   1 . 7  ​ Selecting the Drafting & Annotation workspace

The large, dark gray area you see in the middle of the screen is 
called the drawing area. This infinite canvas is where you’ll create 
your designs; however, it might need to be adjusted. 

	 2.	 Using the View Control tool on the in-canvas Viewport controls, 
select the Top option (see Figure 1.8).

F i g u r e   1 . 8  ​ Selecting the Top option by using the in-canvas  
Viewport controls

This procedure ensures that your view is perpendicular to the 
drawing area. It should be as though you were looking straight down 
at a piece of paper on a drawing table.

	 3.	 From the in-canvas Viewport controls, click the Visual Style control 
to display a list of visual styles. Select the 2D Wireframe option from 
the list, as shown in Figure 1.9.
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F i g u r e   1 . 9  ​ Selecting the 2D Wireframe  
visual style by using in-canvas Viewport controls

If the drawing area looks like a sheet of graph paper, it means the 
grid, a drawing aid that you’ll look at later, is turned on.

	 4.	 Move the cursor to the left side of the status bar at the bottom of the 
screen, and click the Grid Display button so it’s in the Off position 
(unpushed with a gray, not blue, background) and the gridlines disap-
pear. Place your cursor over any button in the status bar to reveal its 
name in a tooltip.

Your screen should now look similar to Figure 1.5.

Introducing the AutoCAD 
Application Window
At the top of the Application window (see Figure 1.10), the Ribbon and the Quick 
Access toolbar sit to the left, and the InfoCenter and a number of related tools 
sit on the right.

Quick Access toolbar InfoCenter toolbar

Ribbon

F i g u r e   1 . 1 0  ​ The Ribbon, Quick Access toolbar, and InfoCenter
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The title bar is analogous to the title bar in any Windows program. It contains 
the program name (AutoCAD or AutoCAD LT) and the title of the current draw-
ing with its path, provided a drawing other than the default Drawing#.dwg is 
open. Below the title bar is the Ribbon, where you’ll find most of the AutoCAD 
commands and tools needed to complete any drawing task. You’ll explore the 
Ribbon in much more detail shortly; however, its basic concept is that related 
tasks are found under the different tabs, which are further segmented into pan-
els containing similar tools.

To the far right of the title bar is the InfoCenter containing the Search, 
Autodesk Online Services, Exchange, and Help buttons. You can enter a ques-
tion in the field to the left of the Search button to quickly access information 
from a number of locations, including the standard AutoCAD help system, 
through the drop-down panel. Autodesk Online Services allows you to sign in 
with your Autodesk ID, and access services that integrate with AutoCAD. The 
Help button is a direct link to the AutoCAD help system (also accessible by 
pressing the F1 key).

As noted earlier, the blank middle section of the screen is called the drawing 
area. Notice the movable crosshair cursor (see Figure 1.11). The crosshairs on 
your cursor might extend completely across the screen. Later in this chapter, 
you’ll see how to modify the length of the crosshairs as well as make a few other 
changes.

F i g u r e   1 . 1 1  ​ The crosshair cursor placed near the UCS icon

Notice the little box at the intersection of the two crosshair lines. This is one 
of several forms of the AutoCAD cursor, known in this form as the Aperture. 
When you move the cursor off the drawing area, it changes to the standard 
Windows pointing arrow. As you begin using commands, it will take on other 
forms, depending on which step of a command you’re performing.



The title bar and 
menu bar at the top 
of the AutoCAD LT 
screen are identical 
to those in AutoCAD, 
except that AutoCAD 
LT appears in the 
title bar rather than 
AutoCAD.
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The icon composed of two lines, labeled X and Y, in the lower-left corner of 
the drawing area is the UCS icon (UCS stands for user coordinate system). It 
indicates the positive direction for the x- and y-axes.

Below the drawing area is the Command Line window, shown in Figure 1.12.

F i g u r e   1 . 1 2  ​ The command-line window

Most commands can be launched in a few different ways (the Command Line, 
Ribbon tools, and so on). Regardless of which method you choose, the Command Line 
window (also called the Command window) is where you will tell the program what to 
do and where the program tells you what’s happening. It’s an important feature, and 
you’ll need to learn how it works in detail. By default, three lines of text are visible. You’ll 
learn how to adjust the number of visible lines later in this chapter, in the “Working in 
the Command Line Window” section. When the Dynamic Input feature is active, much 
of the command window information is displayed alongside the cursor as well.

Below the command window is the status bar (see Figure 1.13).

F i g u r e   1 . 1 3  ​ The left side of the status bar (top) and the right side  
of the status bar (bottom)

On the left end of the status bar, you’ll see a coordinate readout window. In 
the middle are 14 buttons (LT has only 11) that activate various drawing modes. 
It’s important to learn about the coordinate system and most of these drawing 
aids (Snap Mode, Grid Display, Ortho Mode, Object Snap, and so on) early as you 
learn to draw in AutoCAD. They will help you create neat and accurate draw-
ings. You’ll have the chance to explore each of the following drawing modes/aids 
throughout this book; as a preview, however, following is a complete list with a 
brief description of each:

Infer Constraints* ​   ​When this is enabled, AutoCAD will automatically apply 
constraints between objects as you create or modify them.

Snap Mode ​   ​Restricts movement of the cursor inside the drawing area to speci-
fied intervals.

*  Designates drawing modes that are exclusive to AutoCAD and not available in AutoCAD LT.
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Grid Display ​   ​Mimics a piece of graph paper by displaying a series of nonplot-
ting horizontal and vertical lines displayed in the drawing’s background.

Ortho Mode ​   ​Restricts movement of the cursor to 90° intervals: 0°, 90°, and 
270° by default.

Polar Tracking ​   ​Frequently used in conjunction with Object Snap Tracking, 
Polar Tracking is an advanced drawing tool that guides cursor movement to 
specified increments along a polar angle. Its use is introduced in Chapter 5, 
“Developing Drawing Strategies: Part 2.”

Object Snap ​   ​Aids you in drawing objects based on geometric reference points 
such as endpoint, midpoint, intersection, and so on. Mastering the use of object 
snaps is critical in the creation of accurate drawings.

3D Object Snap* ​   ​Similar to the standard object snaps, with more-sophisticated 
tools for working and interacting with 3D faces and edges.

Object Snap Tracking ​   ​An advanced drafting method introduced in Chapter 5, 
this allows you to draw objects with specific geometric relationships to other 
objects within your drawing.

Allow/Disallow Dynamic UCS* ​   ​As noted earlier, UCS stands for user coordinate 
system, and Dynamic UCS is used in 3D drawings.

Dynamic Input ​   ​When enabled, displays much of the command interface near 
the cursor (in addition to the command line itself).

Show/Hide Lineweight ​   ​Toggles the display of lineweights (discussed in 
Chapter 14, “Using Layouts to Set Up a Print”) in the drawing area.

Show/Hide Transparency ​   ​Many objects, including layers, can be assigned a 
transparency value. When this toggle is on, these objects’ transparency settings 
will take effect.

Quick Properties ​   ​Based on the type of object/objects you have selected, Quick 
Properties provides a contextual version of the full Properties palette near the 
selected object/objects. When nothing is selected, the Quick Properties will dis-
appear from the drawing area.

Selection Cycling ​   ​Provides a contextual list of selected overlapping objects, 
making it easier to select the object/objects you intended to select.

*  Designates drawing modes that are exclusive to AutoCAD and not available in AutoCAD LT.
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Te x t-Based Butt ons or Icons?
Sometimes the status bar icons can be a little cryptic. If you prefer, AutoCAD 
can display those buttons as text instead of icons.

Just right-click on any of the icons and deselect Use Icons.

At the right side of the status bar are tools for navigating in the drawing area 
and controlling the display, tools for controlling the appearance of annotation 
objects in AutoCAD, and tools for controlling access to other drawings or features 
within the current drawing. The padlock icon controls which types of toolbars 
and windows are locked in their current positions on the screen. Leave it in the 
unlocked mode for now.

To conclude this quick introduction to the various parts of the Application 
window, you need to understand a couple of items that might be visible on your 
screen. You might have scroll bars below and to the right of the drawing area; 
although they can be useful, they can also take up precious space in the draw-
ing area. They won’t be of any use while working your way through this book, so 
you can remove them for now.

These features can be removed temporarily via the OPTIONS command. The 
following steps show you how:

	 1.	 To access the OPTIONS command graphically, click the Application 
Menu button in the upper-left corner of the AutoCAD window, and then 
click the Options button at the bottom of the menu (see Figure 1.14). 
The OPTIONS command is also accessible from the command line by 
typing OPTIONS ↵. 

The Options dialog box (shown in Figure 1.15) opens. It has ten tabs 
(LT has only eight) across the top that act like tabs on file folders.
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F i g u r e   1 . 1 4  ​ Click the Options button in the Application menu.

F i g u r e   1 . 1 5  ​ The Options dialog box
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	 2.	 Click the Display tab, which is shown in Figure 1.16. Focus on the 
Window Elements group. If scroll bars are visible on the lower and 
right edges of the drawing area, the Display Scroll Bars In Drawing 
Window check box will be selected.

F i g u r e   1 . 1 6  ​ The Options dialog box opened at the Display tab

	 3.	 Click the check box to turn off the scroll bars. Don’t click the OK but-
ton yet.

	 4.	 If you want to change the length of the lines of your crosshair cur-
sor, go to the lower-right corner of the Display tab (the middle of the 
right side for LT), and move the slider to change the Crosshair Size 
setting, as shown previously in Figure 1.18. The crosshair length 
changes as a percentage of the drawing area.

	 5.	 Click OK to apply any remaining changes, and close the Options dia-
log box.
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Choosing Your Own Drawing Area Background Color

By default, AutoCAD uses a dark gray color for the drawing area. Some 
users prefer to customize this and several other user interface elements to 
a color palette of their own liking. As an example, some prefer the contrast 
ratio of a light background color such as yellow or white over the contrast 
ratio offered by the darker background color. Follow these steps to change 
the drawing area’s background color:

	 1.	 Open the Options dialog box by typing OP↵ at the command line, or 
choose Application menu ➢ Options.

	 2.	 Switch to the Display tab, and click the Colors button within the 
Window Elements group.

This opens the Drawing Window Colors dialog box, where you’ll 
customize the colors of the user interface to your liking.

	 3.	 Select 2D Model Space within the Context list, and Uniform Background 
within the Interface Element list of the Drawing Window Colors dialog 
box. The following illustration shows the changing of the colors of user 
interface elements within this dialog box.

(Continues)
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	 4.	 Click the Color drop-down list, and choose a color of your liking from 
the list, or choose Select Color to access a larger array of colors.

	 5.	 Click Apply & Close, and then OK to save your changes and exit the 
Options dialog box.

The Drawing Window Colors dialog box offers several restore options along 
its right side. Think of these as an insurance policy that allows you to quickly 
return things back to the way they were before any colors were customized:

Restore Current Element ​   ​Use to restore the default color of a single 
interface element as selected in the Interface Element list.

Restore Current Context ​   ​Use to restore the default colors for each of 
the interface elements contained within the selected Context.

Restore All Contexts ​   ​Use to restore all contexts and all interface ele-
ments to the default colors used by AutoCAD when it was installed.

Restore Classic Colors ​   ​Earlier releases of AutoCAD employed a solid 
black drawing area background, and a slightly different contrast ratio between 
several other interface elements. Use this option to restore the default color 
scheme used by earlier releases of AutoCAD.

Working in the Command-Line Window
Just below the drawing area is the Command-Line window. This window is sepa-
rate from the drawing area and behaves like a Windows window—that is, you 
can drag it to a different place on the screen and resize it, although you probably 
shouldn’t do this at first. If you currently have fewer than three lines of text in 
the window, you should increase the window’s vertical size. To do so, move the 
cursor to the horizontal boundary between the drawing area and the command 
window until it changes to an up-and-down arrow broken by two parallel, hori-
zontal lines.

Hold down the left mouse button, drag the cursor up by approximately the 
same amount that one or two lines of text would take up, and then release 
the mouse button (see Figure 1.17). You should see more lines of text, but you 
might have to try this a few times to display exactly four lines. A horizontal line 

Choosing Your Own Drawing Area Background Color  (Continued)
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will separate the top two lines of text from the bottom line of text. When you 
close the program, AutoCAD will save the new settings. The next time you start 
AutoCAD, the command window will display four lines of text.

F i g u r e   1 . 1 7  ​ Resizing the command window

The command window is where you give information to AutoCAD and where 
AutoCAD prompts you for the next step in executing a command. It’s a good 
practice to keep an eye on the command window as you work on your drawing. 
Many errors can occur when you don’t check it frequently. If the Dynamic Input 
button on the status bar is in the On position, some of the information in the 
command window will appear in the drawing area next to the cursor. You’ll learn 
about this feature when you start drawing.

Before you begin to draw in the next chapter, take a close look at the Ribbon, 
Application menu, toolbars, and keyboard controls.

N O T E   ​You can start AutoCAD commands in a number of ways: from 
the Ribbon, the Application menu, the command window, and the menus that 
appear when you right-click. When you get used to drawing with AutoCAD, 
you’ll learn some shortcuts that start commands quickly, and you’ll find the 
way that best suits you.

Using the Ribbon
Perhaps one of the most prominent elements of the AutoCAD interface is the 
Ribbon (Figure 1.20). Although the Ribbon can be positioned in various ways, 
its default position extends across the top of the AutoCAD window. Depending 
on the size of your AutoCAD window (or current screen resolution), the Ribbon 
may look a little different on your computer. That’s because the Ribbon self-
adjusts according to the size of the AutoCAD window itself. To see the Ribbon 
in its fully expanded state, you need to be sure to have a screen resolution wider 
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than 1325 pixels. When the width is too narrow to display each panel fully, the 
panels will begin to collapse first by replacing the panels with a single button 
bearing the name of the panel.

Large Tool Icon
(button) Collapsed Ribbon Panel

Small Tool Icon
(button)

Panel

Ribbon Tabs

F i g u r e   1 . 1 8  ​ The Ribbon fully displaying all panels (top) and with partially and 
completely collapsed panels (bottom)

The Ribbon itself can be divided into three parts—tools, panels, and tabs:

Ribbon Tools ​   ​The individual icons and various drop-down lists found on the 
Ribbon are known as Ribbon tools. Clicking any of these tools launches the 
command associated with it.

Ribbon Panels ​   ​Similar tools are grouped together into a series of Ribbon 
panels. For instance, the Move, Erase, and Rotate tools modify objects. 
Consequently, each of these tools is found on the Modify Ribbon panel.
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Ribbon Tabs ​   ​Ribbon tabs offer the highest level of organization; they group 
Ribbon panels by task. For instance, commands related to plotting (printing) are 
found on the Output tab, whereas commands related to entering text can be found 
on the Annotate tab.

Ribbon Enhancements

AutoCAD 2012 introduces several interface and performance enhance-
ments to the Ribbon. Overall Ribbon performance has been enhanced so 
that switching between tabs is nearly instantaneous. Beyond performance 
enhancements, several Ribbon tabs have been updated to make it easier 
to identify and access frequently used tools. These updates include the fol-
lowing Ribbon tabs and panels:

Home tab ➢ Draw panel ​   ​The Draw panel from AutoCAD 2011 is on 
the left, and the updated Draw panel is on the right:

Home tab ➢ Modify panel ​   ​The Modify panel from AutoCAD 2011 is 
on the left, and the updated Modify panel is on the right:

Insert tab ➢ Block panel ​   ​The Block panel from AutoCAD 2011 is on 
the left, and the updated Block panel is on the right:

(Continues)
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Insert tab ➢ Block Definition (formerly Attributes) panel ​   ​The 
Attributes panel from AutoCAD 2011 is on the left, replaced by the new 
Block Definition panel on the right:

Displaying the Ribbon Tools
The Ribbon’s default location is at the top of the screen, but it can be moved or 
docked almost anywhere on your screen. Individual panels have several display 
options built into them as well. In the following exercises, you will have the 
chance to explore many of these display options.

Collapsing, Moving, and Hiding the Ribbon

Available drawing area is always at a premium, and you can regain some of it by 
collapsing the Ribbon: 

�� When you click the Minimize button to the right of the Ribbon tabs 
once, the panels are collapsed vertically, showing only an icon for 
each Ribbon panel. 

�� Clicking the Minimize button a second time collapses the Ribbon 
further so only the tab and panel names display. 

�� Clicking it a third time collapses the Ribbon so only the tabs show. 
When the Ribbon is in any of these states, you can expand any 

panel or tab by clicking its visible panel or tab name. 

�� Clicking the Minimize button a fourth time returns the Ribbon to its 
default state.

Ribbon Enhancements  (Continued)
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Rather than cycling through each display option, you can use the small Down 
icon to the right of the Minimize Ribbon button to quickly switch between states. 
A list of available display states (Figure 1.19) will appear after clicking the Down 
icon. Select the desired visibility to switch directly to it, as opposed to cycling 
through the other options.

F i g u r e   1 . 1 9  ​ List of available Ribbon 
display states

As noted earlier, the Ribbon’s default location is at the top of the screen, but 
it can be undocked, or floating, over the drawing area; or it can be moved to a 
second monitor; or docked on either side of the drawing area. To undock the 
Ribbon, right-click to the right of the tab names and choose Undock from the 
pop-up menu, as shown in Figure 1.20.

F i g u r e   1 . 2 0  ​ Undocking the Ribbon

The Ribbon detaches from the top of the drawing area and floats on the screen, 
as shown in Figure 1.21. To dock it, click the title bar on the side of the floating 
Ribbon and drag it to the side or the top of the drawing area. Experiment with 
detaching the Ribbon, but when you are finished, dock it back at the top so you 
can follow the graphics in this book more easily.

If you don’t want the Ribbon at all, you can turn it off by right-clicking to 
the right of the Ribbon tabs and choosing Close. To turn it on, type RIBBON↵. 
You’ll use the Ribbon throughout this book, so be sure to keep it on for now.
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F i g u r e   1 . 2 1  ​ The Ribbon undocked 
from the top of the drawing area

Using the Ribbon Tools
Each panel contains tools from a related family of functions. For example, all 
the common tools for editing objects in the drawing area are consolidated in the 
Modify panel. When more tools are available than will fit on the panel, an arrow 
is displayed on the panel’s title bar. Clicking the title bar expands the panel and 
exposes the additional tools. Follow these steps to learn how the Ribbon tools 
work and how they display information:

	 1.	 Click the Home tab on the Ribbon to expose the Home tab’s panels 
(see the top of Figure 1.18 shown earlier).

	 2.	 Move your cursor over the Modify panel, and pause the cursor over 
the Move tool button.

This exposes the button’s tooltip, as shown at the top of Figure 1.22. 
Displaying the name of the tool, the tooltip also provides a brief 
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description of its function, the command line equivalent of clicking 
the tool, and instructions to press the F1 key to open the AutoCAD 
Help file to the current tool’s Help page.

F i g u r e   1 . 2 2  ​ The tooltip for the Move command

	 3.	 After a few seconds of hovering over the Move tool button, the tooltip 
is replaced with a cue card, as shown in Figure 1.23. Cue cards show 
the step-by-step implementation of the tool.

F i g u r e   1 . 2 3  ​ The cue card for the Move command

	 4.	 Click the Modify panel’s title bar to expand the panel and expose all of 
the Modify tools (see Figure 1.24).

F i g u r e   1 . 2 4  ​ The expanded Modify panel
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	 5.	 Often, you may find yourself returning to the same tool on an 
expanded Ribbon panel. When that happens, you can pin the panel 
open by clicking the pushpin-shaped button in the bottom-left cor-
ner. When the panel is pinned open, it remains open even when the 
cursor is not hovering over it.

	 6.	 Click the button again to unpin the panel, and then move the cursor 
off the panel to collapse it. Regardless of whether a panel is pinned or 
unpinned, it will automatically collapse if you change Ribbon tabs.

	 7.	 Holding the mouse button down, click the Modify panel title, and 
move the cursor toward the drawing area. 

The Modify panel becomes semitransparent, allowing you to place it 
inside the drawing area to become a floating panel (see Figure 1.25). 
Floating panels display regardless of whether their host tab is current 
or not. This feature can be helpful when quick access to tools on sepa-
rate Ribbon tabs is needed simultaneously. 

F i g u r e   1 . 2 5  ​ Dragging the Modify panel 
from the Ribbon (top), the Modify panel as a 
floating panel (bottom)

	 8.	 To return the Modify panel to the Ribbon, hover over its title and 
then click the Return Panels To Ribbon button shown in Figure 1.26.

Return Panels to 
Ribbon button

F i g u r e   1 . 2 6  ​ Using the Return Panels 
To Ribbon tool to restore a floating panel to 
its host Ribbon tab
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Using the Application Menu
The Application menu contains the tools for opening, saving, and printing (plot-
ting) your drawings, similar to the options found under the File drop-down menu 
in AutoCAD and many other programs. When the Application menu is open, the 
menus for these tools project from the upper-left corner of the AutoCAD window 
and cover the drawing area and any open dialog boxes.

	 1.	 Click the Application Menu button to open the Application menu.

	 2.	 The left pane of the Application menu displays the different com-
mands. Clicking or hovering over a command displays a menu of its 
options in the right pane, as shown in Figure 1.27.

F i g u r e   1 . 2 7  ​ The Application menu 
showing the Print options

A bar with an up- or down-arrow at the top or bottom of the right 
pane indicates that additional tools are available. You can display 
these tools by placing your cursor over either bar.

P

Be careful not to 
double-click the 
Application menu, 
because this will 
make AutoCAD 
close.
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Opening a Drawing with the Application Menu
The Application menu offers a quick method for opening drawings. You can even 
see a thumbnail preview of the drawings and arrange drawings that you fre-
quently edit so they are easily accessible. Here’s how:

	 1.	 To open a new AutoCAD file from the Application menu, choose 
New ➢ Drawing, as shown in Figure 1.28.

F i g u r e   1 . 2 8  ​ Opening a new drawing from 
the Application menu

This opens the Select Template dialog box, where you select a tem-
plate on which to base the new drawing. Opening a file with a template 
is covered in Chapter 2, “Learning Basic Commands to Get Started.”

	 2.	 To open an existing file from the Application menu, choose Open ➢ 
Drawing, as shown in Figure 1.29.

F i g u r e   1 . 2 9  ​ Opening an existing drawing from 
the Application menu

This opens the Select File dialog box, where you can navigate to 
the desired drawing file and select it.
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	 3.	 To open a file that you’ve worked on recently, click the Recent 
Documents button at the top of the Application menu’s left pane. 
This displays the most recent files opened in AutoCAD in the right 
pane, as shown in Figure 1.30.

F i g u r e   1 . 3 0  ​ Displaying the recent 
documents in the Application menu

	 4.	 Hover over a filename in the right pane to display a thumbnail preview 
of the drawing and additional information, including the drawing loca-
tion and AutoCAD drawing format (see Figure 1.31).

F i g u r e   1 . 3 1  ​ Displaying a thumbnail of the selected file
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Opening New Files

You can open new or existing files by using the New or Open button in the 
Quick Access toolbar. Existing drawings can also be opened by dragging 
them from a Windows Explorer window to the AutoCAD title bar.

N O T E   ​AutoCAD 2012 uses the AutoCAD 2010 drawing (DWG) file 
format. This means that the files created in AutoCAD 2012 are compatible 
only with AutoCAD 2010, AutoCAD 2011, and AutoCAD 2012. You can share 
drawings with releases earlier than AutoCAD 2010 by performing a simple 
conversion. To convert a 2010 format drawing to a prior version, open the 
Application menu and then click Save As ➢ AutoCAD Drawing and choose 
the version you want from the Files Of Type drop-down list at the bottom of 
the Save Drawing As dialog box.

016770c01.indd   29 6/20/11   2:13 PM



3 0 	 C h a p t e r  1  •  G e t t i n g  t o  K n o w  A u t o C A D

Getting the Most Out of the Recent Documents List

The Application menu offers many time-saving tips. Here are two of the 
best ways to use the Recent Documents list:

Access Frequently Used Drawings ​   ​For drawings you access on a 
regular basis, and would like to remain on the Recent Documents list, click 
the pushpin that displays next to its name. This will “pin” that drawing to 
the Recent Documents list until you unpin it.

Maximize the Number of Recent Documents ​   ​Out of the box, the 
Recent Document list displays only the last nine drawings you’ve opened. 
This number can be increased to fifty using the OPTIONS command, selecting 
the Open and Save tab, and changing the Number Of Recently-Used Files 
setting under the Application Menu heading.

Switching between Open Drawings
As in many programs, you can have multiple drawing files open in the same 
session of AutoCAD. Each drawing is stacked behind the drawings in front of 
it. There are several ways to switch between the open files, including using the 
Application menu, as shown next:

	 1.	 Start or open two or more AutoCAD files.

	 2.	 Open the Application menu, and then click the Open Documents icon 
at the top of the left pane. The open drawings are displayed in the right 
pane, as shown in Figure 1.32.

F i g u r e   1 . 3 2  ​ Displaying the open drawings 
by using the Application menu
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	 3.	 Click on any drawing to bring it to the front of the AutoCAD window.

	 4.	 You can change the way AutoCAD displays the list of open drawings 
by clicking the icon near the top of the right pane and choosing one 
of four sizes of icons or thumbnail images to represent the open 
drawings.

Another option for switching between open drawings is to click the Quick 
View Drawings button in the status bar. This displays thumbnails for the open 
drawings, and you can click any thumbnail to make its drawing active. Hovering 
over a thumbnail displays that drawing’s layouts (see Figure 1.33). Layouts are 
designated views of the drawing with scaled viewports looking into the drawing 
model. Viewports are covered in Chapter 14.

F i g u r e   1 . 3 3  ​ Displaying the open drawings with 
the Quick View Drawings tool

Using the Drop-Down Menus
If you prefer to use drop-down menus, they’re still available in AutoCAD 2012, 
although they are turned off by default in the Drafting & Annotation, 3D Basics, 
and 3D Modeling workspaces. You can display them by switching to the AutoCAD 
Classic workspace, clicking the down-arrow at the right end of the Quick Access 
toolbar, and choosing Show Menu Bar (see Figure 1.34), or by typing MENUBAR↵1↵. 
This book focuses on the use of the Ribbon; the menus are covered here so you’ll 
be familiar with them if you use them in the future.
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F i g u r e   1 . 3 4  ​ Turning on the menu bar

The left end of the menu bar, just below the title bar (see Figure 1.35), con-
sists of an icon and 13 menus (11 if you don’t have the Express Tools installed 
or are using LT). Click any of these to display a drop-down menu. The icon and 
the File and Edit menus are included with all Windows-compliant applications, 
although they are somewhat customized to work with AutoCAD. The drop-down 
menu associated with the icon contains commands to control the appearance 
and position of the drawing area.

F i g u r e   1 . 3 5  ​ The AutoCAD user interface showing the menu bar

You can turn off the menu bar by clicking the down-arrow on the right end of 
the Quick Access toolbar and choosing Hide Menu Bar, or by typing MENUBAR↵0↵.

Using the Toolbars
The AutoCAD toolbars have essentially been replaced by the Ribbon or other 
features, so we’ll touch on them only briefly here. Toolbars, like the Ribbon pan-
els, are collections of tools grouped by similar tasks. Like the Ribbon itself, any 
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toolbar can be displayed or hidden without affecting the others, and they can all 
be docked to a side or the top of the drawing area or float freely. 

Although the Ribbon has largely filled the role toolbars once played inside the 
software, some tools are still found only on toolbars. For this reason, some opt 
to build a hybrid workspace utilizing both toolbars and the Ribbon in tandem. 
A popular example of where this functionality may prove helpful is the Object 
Snap toolbar, which lacks a Ribbon equivalent. 

Object Snaps are tools used to ensure accuracy as a plan is drawn, and are dis-
cussed at length in Chapter 4, “Developing Drawing Strategies: Part 1.” To load 
the Object Snap toolbar into your current workspace, do the following:

	 1.	 On the Ribbon, click the View tab.

	 2.	 Click the Toolbars tool on the Windows panel to display a list of tool-
bar sets. Choose AutoCAD ➢ Object Snap from the list to open the 
Object Snap toolbar (see Figure 1.36).

F i g u r e   1 . 3 6  ​ Loading the Object Snap toolbar

Similar to Ribbon panels, toolbars may be floating or docked. 
Floating toolbars are not connected to the Application window in any 
way, whereas docked toolbars will move with the application as it’s 
moved between monitors, or even resized on a single monitor.

	 3.	 Drag the Object Snap toolbar to your desired location. Dragging the 
toolbar near any edge of the drawing area will dock the toolbar to 
that edge of the user interface. Figure 1.37 shows the Object Snap 
toolbar docked to the right edge of the drawing area.
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Object Snap toolbar

F i g u r e   1 . 3 7  ​ The Object Snap toolbar docked to the Application window

Take a few minutes to explore the available toolbars, and then close all but the 
Object Snap toolbar and hide the display of the menu bar. 

Saving Workspaces
At the start of this chapter, you learned how workspaces can dramatically change 
the overall appearance of AutoCAD. This was illustrated in the “Exploring the 
AutoCAD User Interface” section of this chapter as you switched between dif-
ferent workspaces that ship with the software. Although many find the default 
workspaces more than adequate, others may prefer custom tailoring the user 
interface to the way they work.

From customizing the Ribbon, to loading toolbars, and beyond, AutoCAD pro-
vides a large collection of tools to personalize its layout. Regardless of the extent 
of your customization efforts, that configuration will be lost unless it’s first saved 
as a workspace.

In the preceding section, you loaded the Object Snap toolbar. Follow these 
steps to ensure that it remains the next time you start AutoCAD:

	 1.	 Click the Workspace Switching drop-down list next to the Application 
menu, or on the right side of the status bar, and choose Save Current 
As from the menu, as shown on the left in Figure 1.38. This opens 
the Save Workspace dialog box, shown on the right in Figure 1.38.
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F i g u r e   1 . 3 8  ​ The Save Workspace dialog box

	 2.	 Type AutoCAD NER as the name for the workspace and click Save. 
The dialog box closes, and you are returned to your workspace. 

Until you change it or select a different workspace, the AutoCAD 
NER workspace setup will remain as it is now.

When you make changes to a workspace by adding a toolbar or changing the 
background color of the drawing area, you can easily update the current work-
space to accommodate those changes. Follow steps 1 and 2, naming the work-
space again with the same name. You’ll get a warning window telling you that 
a workspace by that name already exists and asking whether you want the new 
arrangement to replace the old one. Click Yes.

Using the Keyboard
The keyboard is an important tool for entering data and commands. If you’re a 
good typist, you can gain speed in working with AutoCAD by learning how to 
enter commands from the keyboard. AutoCAD provides what are called alias 
commands—single keys or key combinations that start any of several frequently 
used commands. A good example of a command alias that ships with AutoCAD 
is the LINE command. Of course you could type LINE at the command line to 
launch the command, but typing the one-character alias L is much quicker and 
easier. You can add more aliases or change the existing ones as you become more 
familiar with the program.

In addition to the alias commands, you can use several of the F keys (function 
keys) on the top row of the keyboard as two-way or three-way toggles to turn 
AutoCAD functions on and off. Although buttons on the screen duplicate these 
functions (Snap, Grid, and so on), it’s sometimes faster to use the F keys.

While working in AutoCAD, you’ll need to enter a lot of data (such as dimen-
sions and construction notes), answer questions with Yes or No, and use the 
arrow keys. You’ll use the keyboard constantly. It might help to get into the habit 
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of keeping your left hand on the keyboard and your right hand on the mouse if 
you’re right-handed, or the other way around if you’re left-handed.

Using the Mouse
Your mouse most likely has two buttons and a scroll wheel. So far in this chap-
ter, you have used the left mouse button to choose menus, commands, and 
options, and you’ve held it down to drag the Ribbon. The left mouse button is 
the one you’ll be using most often, but you’ll also use the right mouse button.

While drawing, you’ll use the right mouse button for the following three 
operations:

�� To display a menu containing options relevant to the particular step 
you’re in at the moment

�� To use in combination with the Shift or Ctrl key to display a menu 
containing special drawing aids called object snaps

�� To display a menu of toolbars when the pointer is on any icon of a 
toolbar that is currently open

The middle button with a scroll wheel serves a dual function:

�� Pressing and holding the middle button enables you to pan through-
out your drawing until you release the middle button.

�� You can zoom in/out within your drawing: When scrolling toward 
the screen, you zoom into your drawing. Conversely, when scrolling 
away from the screen, you zoom out from your drawing.

AutoCAD makes extensive use of toolbars and the right-click menu feature. 
This makes your mouse an important input tool. The keyboard is necessary for 
inputting numeric data and text, and it has hot keys and aliases that can speed 
up your work; however, the mouse is the primary tool for selecting options and 
controlling toolbars.

The next chapter will familiarize you with a few basic commands that will 
enable you to draw a small diagram. If you want to take a break and close 
AutoCAD, choose Application menu ➢ Exit AutoCAD (lower-right corner), and 
choose not to save the drawing.
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Are You Experienced?
Now you can…

EE recognize the elements of the AutoCAD Application window

EE understand how the command-line window works and why it’s 
important

EE start commands from the Ribbon

EE start commands from the command line

EE use the Application menu

EE display the drop-down menus

EE open and control the positioning of toolbars

EE save a workspace of your screen setup in AutoCAD
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